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WELCOME

Congratulations on purchasing your Visioneer 4800 USB scanner. With 
your scanner, you can quickly scan paper documents and color photos 
to place their electronic images on your computer.

WHAT’S IN THE BOX

Before starting the installation, check the contents of the box to make 
sure that all parts are included. If any items are missing or damaged, 
contact the dealer where you purchased the scanner. 

Note: In addition to this Installation Guide you’re reading, the 
Installation CD also includes the ScanSoft PaperPort Online 
Documentation, the guide for the ScanSoft PaperPort software. You 
can print a copy of either of these guides from the CD to your printer.

Installation CD Power supply 

Visioneer 4800 USB Scanner
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THE VISIONEER 4800 USB SCANNER
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Document cover. Close the document cover after placing items on the scanner glass.

Document pad. Helps to secure the document in place on the scanner glass.

Glass. Place items face down on the glass, aligned at the lower left corner.

Reference frame. Place items face down within this frame. Markings for inches and 
centimeters appear along the border of the frame.

Power jack. Plug the scanner’s power supply into this jack.

Universal Serial Bus (USB) cable. Plug this cable into your computer’s USB port. 

Note: The scanner does not have an on/off switch. Simply start the ScanSoft 
PaperPort software, or other software application that supports scanning, and scan 
from it. For more information, see “Setting Up the Scanner” on page 9.
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WHAT YOU NEED 

To use the scanner and software, you need the following:
■ IBM PC (or 100-percent compatible) Pentium or equivalent 

■ Microsoft Windows 98, Windows 2000, or Windows Me

■ One available Universal Serial Bus (USB) port on your computer

■ 32 megabytes (MB) or more of available internal memory (RAM)

■ 70 MB of free hard disk space

■ A VGA or SVGA monitor. Recommended settings for your monitor 
are as many colors as possible—High Color (16-bit), True Color 
(24-bit or 32-bit). Set the resolution to at least 800 by 600 pixels. 
To set your monitor’s colors and resolution, open the Windows 
Control Panel, double-click Display, and then click the Settings tab.

■ A CD-ROM drive

GETTING THE PAPERPORT ONLINE DOCUMENTATION

The Installation CD also includes your ScanSoft PaperPort Online 
Documentation. This manual provides more detailed information about 
PaperPort’s features. Please see the CD to view the manual. You can also 
print the manual from the CD.

GETTING HELP

The PaperPort software includes a complete help system that answers 
questions about the scanner and its software. If you have questions, or 
the scanner doesn’t seem to work correctly, please use the help system.

To get help while using the PaperPort software:
■ Press the F1 key, or from the Help menu, choose PaperPort Help 

Topics to display the Help Topics window.
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INSTALLING THE SCANNER SOFTWARE

To install the scanner software:
1. Start Microsoft Windows 98, 2000, or ME and make sure that no 

other applications are running.

2. Insert the CD into your computer’s CD-ROM drive. The CD 
automatically starts.

3. When the CD window appears, click the button PaperPort Deluxe 
and follow the instructions on the screen to install the software on 
your computer. You can install other applications on the CD later.

When you are finished installing the software, a message on the 
screen instructs you to connect the scanner to the computer.

4. Do not remove the CD from the computer yet. You can install the 
other applications on the CD after connecting the scanner.

Note: You must install the scanner software before connecting the 
scanner to your computer. Otherwise, the correct driver software for 
your scanner will not be installed and it may not work properly. 

Note: If the CD does not automatically start, make sure the CD 
drive’s door is completely shut. If the CD still doesn’t start, click the 
Windows icon that shows the drives on your computer. (Usually, the 
icon is named My Computer.) The window shows the drives available 
on your computer. Double-click the icon for your CD-ROM drive to 
see the list of files on the CD. Double-click the file named 
START32.EXE. The CD starts. 
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CONNECTING THE SCANNER 
Your Visioneer 4800 USB scanner connects to any available USB port. 
Check your computer’s manual for the USB port location. 

To connect your Visioneer 4800 USB scanner:
1. Plug the USB cable on the back of your scanner into any USB port 

on your computer.

If the plug does not attach easily, make sure that you are plugging it 
in correctly. Do not force the plug into the connection.

2. Plug the power supply cable into the jack on the back of the 
scanner, then plug the power supply into a wall outlet.

Note: You do not have to shut off the power to your computer when 
connecting the scanner.

Note: If you have not installed the software yet, unplug the cable 
from the computer and install the software now. When the software 
installation is complete a message tells you to connect the scanner.

Power supply USB Cable
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A progress message appears saying that the USB scanner has been 
found. The scanner is now correctly installed.

3. From the CD, install the other software applications to your 
computer.

4. When you are finished installing the other software, remove the CD 
from your computer and store it in a safe place.

SETTING UP THE SCANNER

The steps to set up the scanner identify the type of scanner you have and 
prepares the PaperPort software to scan with it.

To set up the scanner:
1. If the PaperPort software isn’t currently running, double-click the 

PaperPort icon on the Windows Desktop to start it. The PaperPort 
Desktop appears. 

2. From the File menu, choose Select Source. The Select Source 
dialog box appears, listing all Twain devices installed on your 
computer.

Twain devices include scanners, digital cameras, and other 
equipment that can capture images for your computer. Twain is a 
standard method that computers use to receive images from those 
devices.

3. Choose the Scan Manager, and then click Select.

Your scanner is now set to scan.



10 4800 USB SCANNER INSTALLATION GUIDE
SCANNING AN ITEM

You can scan many types of items, from small business cards to A4-sized 
pages. The scanner also has special settings for scanning color photos 
and text documents. 

Your scanner is preset to scan color images. Selecting a new scanner 
setting to scan in black and white reduces the scan time and also 
produces smaller files for the scanned images. For more information 
about scanner settings, see “Adjusting Scanner Settings” on page 13.

To scan an item:
1. If the PaperPort software isn’t currently running, double-click the 

PaperPort icon on the Windows desktop to start it. 

The PaperPort Desktop appears. 

2. Open the scanner cover, place the item you want to scan face down 
aligned at the lower left corner of the scanner glass, and close the 
cover.

3. Click the Twain icon on the PaperPort software’s Command Bar, 
or choose Acquire from the File menu. 

Note: You don’t need to complete Steps 2 and 3 again, unless you 
change the selected source to another Twain device.
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The Scan Manager appears.

4. From the list of Scanner Settings labeled “Scan Page For,” select the 
most appropriate setting for the item you’re scanning. In the 
example above, the selected setting is “Color Document-Faster.”

5. Click the Preview button.

The scanner scans a preview of the item and displays it in the Scan 
Manager. In the example on the next page, the picture being 
scanned is a close-up of a friendly cow.

6. You can now fine-tune the options on the Scan Manager for the 
item you’re scanning.

Note: For additional details about the Scan Manager’s features click 
the Help button on the Scan Manager.
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7. Check the preview image. If you want to change the scanner setting 
for the item, click one of the options in the list to “Scan Page For.” 

For example, to scan a black and white image instead of a color 
photo, select Black & White Photo in the list. 

See the table in the section “Selecting a Predefined Scanner Setting” 
on page 14 for a description of these predefined settings.

8. Select the area of the item you want to scan.

When you preview an item to scan, the selection rectangle around 
the image indicates the scan area. However, you may want to select 
only a certain area of an item to scan. Selecting an appropriate scan 
area can result in a faster scan and a smaller file size.

The scanned image’s file size and available space on your computer’s 
hard drive are shown at the bottom left side of the Scan Manager. 

Select another 
scanner setting if 
you want it for 
the item being 
scanned.

Select other set-
tings here if want 
them for the item 
being scanned. 
You also use these 
settings to cus-
tomize a scan set-
ting.

To adjust the 
size of the scan 
area, or crop the 
image, drag the 
borders of the 
selection rectan-
gle surrounding 
the item.

Click Scan to scan the 
item and display it in 
the application.

Click Preview to check the 
image again until it’s what 
you want for scanning.
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9. To select the area to scan, drag the borders of the selection rectangle 
surrounding the preview image to reduce or enlarge the area.

10. If you want to preview the item again with the new settings, click 
the Preview button again on the Scan Manager.

11. When you are satisfied with the preview image, click the Scan 
button on the Scan Manager. 

The scanned item appears as a thumbnail image in the ScanSoft 
PaperPort Desktop.

ADJUSTING SCANNER SETTINGS

You can adjust the scanner settings to fine tune the scanned item. 
This section tells you how to:

■ Select a predefined scanner setting.

■ Select scan configuration options.

■ Customize a scanner setting.

■ Adjust the brightness and contrast.

■ Select the area of the item you want to scan.

Thumbnail image
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SELECTING A PREDEFINED SCANNER SETTING

In the Scan Manager, you can select one of the predefined scanner 
settings from the list “Scan Page For.” The settings are described in the 
following table. 

Scan Page For Default Setting To Scan Description

Editing Text 
(OCR)

Black-and-white
300 dpi

Business letters, 
contracts, memos, and 
other documents that 
you want to edit

Enhances the use of OCR 
software for converting item 
text to editable text. Provides 
higher quality and a larger file 
size than the Faxing, Filing or 
Copying scan setting. 

Faxing, Filing, 
or Copying

Black-and-white
200 dpi

Newspaper and 
magazine articles, 
receipts, forms, and 
other text items

Provides the fastest scan time 
and smallest file size.

Black & White 
Photo

Grayscale
100 dpi

Black-and-white photos Provides the best setting for 
black-and-white photos.

Color 
Document—
Faster

Color
100 dpi

Color pages with many 
graphics, or mixed 
graphics and text, line 
art, or photos that 
require a quick scan

Creates a reasonable scanned 
color item in a file that is not 
too large. This is the scanner’s 
default setting.

Color 
Document—
Better Quality

Color
200 dpi

Photographs and color 
items

Provides the ideal setting for 
color items, item editing, 
desktop publishing, and high-
quality output. Results in a 
color scan with slower scan 
time and a larger file size. 

Custom Color
100 dpi

Any item You select all the options for 
scanning. Also used to create 
and add a new scan setting to 
the list.
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Selecting the proper scanner setting before scanning produces the best 
results for a scanned item. The scanner setting determines the resolution 
of the item and the number of possible shades of gray or color. The 
symbols next to the setting names indicate the scan mode—color, 
grayscale, or black and white. The scanner settings affect the speed of 
the scan and the file size. The Scan Manager shows the approximate file 
size of a scanned item to help you decide whether to use a particular 
scanner setting.

SELECTING SCAN CONFIGURATION OPTIONS

The scan configuration options provide you with additional settings 
when scanning an image. Note that when you select one of the 
predefined scanner settings, these options show what is already selected 
for that setting, but you can change them as you wish.

The options are:

Mode—Shows the scan mode such as true color, grayscale, and black-
and-white. Click the drop-down arrow to see your choices for the scan 
mode. The symbols next to the selections indicate their mode setting. 
Choose one of the modes for scanning from the list.

Res—This is the resolution setting for the scan in dots-per-inch (dpi). 
The higher the dpi, the sharper the image. But higher dpi settings also 
produce larger files sizes. Usually the higher resolution settings are used 
for precision work, such as photographs or fine artwork. Click the drop-
down arrow and choose one of the resolution settings from the list.

Color Grayscale B&W

Note: Your scanner is initially set to scan with the setting Color 
Document—Faster. To scan at a higher resolution, select Color 
Document—Better Quality. Note, however, that scanning at a higher 
resolution creates a larger file size, takes longer to scan, and may not 
print any better. To minimize the file size and the time required to get 
a better quality scan, select just the area of the item that you want to 
scan. For more information about selecting the area of an item, see 
“Selecting the Area of the Item You Want to Scan” on page 18.
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Size—The page size for the image. If you want to use one of the preset 
sizes, click the drop-down arrow and choose the size from the list. If you 
want to create a custom size, click on the picture window and drag the 
mouse. A dotted box on the window indicates the page size, and the two 
number boxes—with the vertical and horizontal symbols next to 
them—show the actual page size in inches. You can also enter the 
vertical and horizontal sizes in those two number boxes. To set the units 
for the sizes, click the drop-down arrow for the size units. The choices 
are inches, cm (for centimeters), and pixels.

AutoCrop—Select this option to let the scanner automatically 
determine the size of the item being scanned. For example, if you put a 
photo in the middle of the glass, the scanner will automatically 
determine the size of the photo. When AutoCrop is selected, the 
scanner makes two passes—the first pass senses the item’s size, and the 
second pass scans the image. This option overrides the selections for 
Size.

Adv. Settings—Click this button to see advanced settings for scanning. 
See the online Help information for details about the advanced settings.

CUSTOMIZING A SCANNER SETTING

You can create custom settings to add to the list of options on the Scan 
Manager. 

To create a new scanner setting:
1. In the Scan Page For options, select Custom to create a new 

scanner setting.

2. In the Scan Configuration options, select the options you want for 
your custom setting.

3. If you want to adjust the advanced settings for your custom setting, 
click the Adv. Setting button. Click the Help button to see more 
information about the advanced settings.

Note: Predefined settings cannot be customized.
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4. Click the Save As button.

The Save As dialog box appears.

5. Type a name for the new scanner setting. 

6. Click Save.

The new setting is added to the list of “Scan Page For” options at the 
top of the dialog box. 

ADJUSTING THE BRIGHTNESS AND CONTRAST

Sometimes an item is scanned with the brightness and contrast set to be 
too light or too dark. For example, a note written with a light pencil 
may need to be scanned darker to improve legibility. 

You can adjust the brightness and contrast at which grayscale and color 
items are scanned. You can also adjust the brightness for black-and-
white items. 

To adjust brightness and contrast:
1. Click the Adv. Settings button on the Scan Manager. The 

Advanced Settings dialog box appears.

2. Select the User Defined option.

Drag to adjust brightness

Drag to adjust contrast
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3. Drag the Brightness slider to the left to make the item darker or to 
the right to make the item lighter. 

4. Drag the Contrast slider to the left to decrease the contrast or to 
the right to increase the contrast. 

5. Click OK on the Advanced Settings dialog box.

SELECTING THE AREA OF THE ITEM YOU WANT TO SCAN

When you preview an item to scan, the selection rectangle around the 
image indicates the scan area. However, you may want to select only a 
certain area of an item to scan. Selecting an appropriate scan area can 
result in a faster scan and a smaller file size.

To select the area you want to scan:
1. Click the Preview button. An image of the scanned item appears in 

the Preview area. A selection rectangle shows the current scan area.

2. (optional) In the Scan Configuration settings, select the units of 
measure you want to use for the scan area. You can select either 
inches, centimeters, or pixels.

3. To change the dimensions of the rectangle, click the rectangle, and 
then drag the borders of the rectangle to resize it. This effectively 
allows you to crop the item. The dimensions of the selected area 
appear in the Scan Configuration settings.

You can also type length and width dimensions directly into the 
boxes that show the dimensions of the selection area. Use this 
process to produce a precise scan area size.

4. To position the rectangle over the area you want to scan, click and 
hold the left mouse button and drag to the location desired.

5. Click the Scan button to scan the image.

Note: For more detailed information on advanced settings, click the 
Help button on the Scan Manager.
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INSTALLATION TROUBLESHOOTING

After I installed PaperPort, I got a blue screen and a Profiling 
Display error message. Why is this happening? PaperPort installs a 
driver for scanning and printing. Sometimes a conflict occurs between 
the PaperPort driver and another driver you may have on your 
computer. To resolve the conflict, remove the PaperPort driver from 
your SYSTEM.INI file and restart your computer. If the computer 
starts properly, that is a good sign that the conflict occurred.

You can also change your video driver to SVGA and reboot with our 
driver in the SYSTEM.INI file. This will help you tell if the video driver 
conflicts with the PaperPort driver. 

During installation I got the error message: PaperPort Installation 
is not complete. What do I do? The installation procedure was not 
successful. You need to reinstall the PaperPort software.

I got the error message: PaperPort cannot allocate enough memory 
to perform internal critical operations. What do I do? You should 
close any other active applications so that additional memory is 
available. If you click continue, PaperPort moves the file to the 
PaperPort data directory and renames the file with the prefix “bad.” 
This allows you to recover the file later.

To recover the file, you can import it into PaperPort by using the Import 
command in the File menu.

How do I uninstall PaperPort? You can uninstall PaperPort in the 
Windows Control Panel. To display the Control Panel, choose Settings 
from the Start menu, then choose Control Panel. Double-click 
Add/Remove Programs. Use the Install/Uninstall tab to remove 
ScanSoft PaperPort from your hard disk. The uninstall does not delete 
your scanned items, and they remain in the PaperPort Data folder.

Note: Windows stores the SYSTEM.INI file in the Windows 
directory.



20 4800 USB SCANNER INSTALLATION GUIDE
CLEANING THE SCANNER GLASS

Scanning items that have excessive amounts of dirt or dust may dirty the 
glass. To ensure the best quality scanned item, wipe the scanner glass 
with a soft clean cloth to rid the glass of dust or other debris.

CONTACTING VISIONEER FOR TECHNICAL SUPPORT

Free Support by Telephone 
(8:00 am - 5:00 pm Pacific Time, Monday-Friday)

(541) 884-5548

Free Support on the Web www.visioneer.com

Free 24-hour Automated Expert System (888) 887-0092 
(Toll Free)

Free Support by Fax (541) 884-8474

Express Telephone Support 
(8:00 am - 5:00 pm Pacific Time, Monday-Friday)

(900) 776-5724 
(Nominal per-minute fee)
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VISIONEER 4800 USB SCANNER SPECIFICATIONS

Bit Depth 48-Bit color (internal), 16-Bit gray
(internal), 1-Bit line art/text

Scanning resolution Optical resolution: 
600 x 1200 dpi
Maximum resolution (interpolated):
9600 x 9600 dpi

Maximum Item sizes 8.5 x 11.69 inches (21.6 x 29.7 cm)
Scanner dimensions
Height 3.4 inches (8.5 cm)
Width 11.4 inches (29.0 cm)
Length 17.5 inches (45.0 cm)
Weight 5.6 pounds (2.5 kg)
Operating temperature 50°–104° F (5°–35° C without condensation)
Relative humidity 20%–80% (@35° C without condensation)
Power supply
Input voltage/frequency 100 Vac, 50/60 Hz (Japan)

120 Vac, 60 Hz (North America)
230 Vac, 50 Hz (Europe)

Output voltage/watt 12 V DC, 15 watt maximum
Safety and agency certifications UL, ULc, FCC Class B, 

VCCI Class B, CE
Hardware warranty One-year limited warranty
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